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Overview

This article shows how to add Attribute Values, Attribute Dates, and Attribute Notes into the grid as columns for reporting purposes.

This can be very useful for a wide variety of reasons. One example would be to pull the canvassing results from one of your mobile walks lists into

a report to see total counts for each answer, as well as the date the voter was canvassed. It can also be useful when re-entering data form a
physical paper walk list (covered in the last section of this article).

« Tips: Get up to speed on how to create new Attribute Folders/Items, and how to save custom Formats for future use.
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& TrailBlazer

Oroanbe. Leverage. Succeed. Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

Navigate to your contacts list (Voters/Donors) and run your search query. In my example | pulled up anyone who had any of the attributes | used as
questions in my mobile canvassing list, it returned 2061 records.
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Construct your query and click [Search].

£) Help
Application Menu <3» Search . Reset | 4k New 0= | ) OF @ | File » Edit » | & | 8gInclude Other | Voters

[El:-R=¥e] Q

Ta | Favorites | General | Address [ Housshold | Viote History | # Attibute | Canvass | Poll | Lawn Sign [ Contribute | Pledge | Evert [ Log | Ad
Ihﬂi“ﬂll
- § Calendar/Tasks # Include | Exclude
|_‘_| % Voter
-8 Voters —— 1 % © In precisely Attribute Yes Date From  Date To Note

-.[8{ Minnescta Vater List 'E?E' In at least F-  Volurteers
(1 In range

Il

E-{— WVoter Candidate Support
Households B8 Does Not Support
[l VWoter Relationships N e E I —

F_'I Lawn Signs of 3 selected %E Undecided
+-“#p Contributions/Pledges
- Product Sales
- Logs
+-7 Communications

]a Financial EE[Edit # Include % Exclude @Sﬂrt @Format - mEE}q::u::rrt &Print IE] Surnrmary ED E Pivot |

1 (=1 == | =]

Flr— Vinter loe ise

+-41% Disclosure Voters [ 2061 records found ]
iy System Manager - = First Addeess

Zip Birth
MName “ Name MI Type Address State Code Date

Rich Pac |_ & [12526 270h Ave [ lsle IT 56342
Aabbatt-Strili... | Jameas 103 Meadowlark Rd ... || 5t Michael 55376 1/1/1549
Aabel Jenfer 1910 Siou Bivd New Brighton | MN | 55112 1/1/1960
Aabel John 1910 Siow Bivd New Brighton 55112 1/1/1961
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Select the Format drop-down button, and choose Columns.
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<3v Search %, Reset | 4k New 0= | L) OF @ | File + Edit - | 0 | 8gInclude Other | Voters
%]

| Favortes | General | Address | Household | Vote History | &% Attribute | Canvass | Poll | Lawn Sign | Contribute | Pledge | Event | Log | Admin | saL |

A Include Exdudel

.3-;:. i precisely fes Date From
i@ In at least Donor Level

& |

_) Inrange Lawn Sign Reguests

Mot - Hidden,/Archived Records
I el #= Place your order

of 2 selected +- Social Networking

Snlirre

1 nal

Click on the [Format] drop-down menu and
setect 'Columns'

SEEdit | % Include % Exclude | Sort [ Format ~ || &% Export /& Print ||[E] Detail |@ Summary [[] = | [E Pivot .
Voters [ 2061 records found ] <System Format>

First |@ Columns... | Birth
Homs Eu Select other...

Rich Pag Aitlin
Aabbatt-Strli... | James H i e 8 i [ g = =] L s s ] T Wright
Aabel Jenifer ;,@ Save As,., Blvd Mew Brighton | MM | 55112 111960 Ramse

Gend Cou

Save

Aabel John Blhvd Mew Brighton | MM | 55112 1/1/1961 Famse

Assign as default...

Aaberg Allan Ave Starbuch MM | 56381 111961 Fope
Aaberg Jamon 3915 Moble Ave M Robbinsdale hhdF? 111571 Herne
Aaberg Marjory S04 Bth St E Starbuck MN | 56381 1/1/1561 Pope
Aaker Kahmn { 20644 Justice Path Lakeville MN | 55044-5574 111977 Diakeots
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Navigate to the Attributes tab, locate and expand the folder(s) of Attributes you want to add to the grid, check all of the boxes under the
Setting/Date/Note columns, and the click [OK].
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9 Column Selection 1

—
Atributes “,ta(e Histony I Format |
Attributes

Daonor Lewel

Lawn Sign Reguests

Mot - Hidden/Archived Records
Place your order

Social Netwarking

Source

||

Yolunteers

~28 Does Mot Support
“E Suppon

B Uraocacd
+-— Voter lssues

I ({22052 | S
I ({2 I0{E=2] | S

I [N S g

4
(© o oo

The system will add the columns to the far right of the grid (outlined in red in the screenshot below).
KNOWLEDGE BASE www.trailblz.com/kb 7



http://www.trailblz.com/kb

& TrailBlazer

Oroanbe. Leverage. Succeed. Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

(Optionally you can click-and-drag on the column header left or right to rearrange the order in which they appear.)
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(%]

<JrSearch ¥, Reset | 4 New 0o L) CF @ | File  Edit » | ¢ |SgInclude Other | Voters

| Favorites | General | Address | Household | Vote History | 4% Attribute | Canvass [ Fol

A Include | Bxclude

| Lawn Sign | Contiibute | Fledge | Event [ Log | Admin | sGL |

Q

e+

O In precisaly Atribute Yes Date From Date To Note
@ In at least S-Er Voter Candidate S
() Inrange =
Ohnal E% T Ml sSopest
1 w0 = =" -
of 3 selected B-{Z Voter Issues

Voters [ 2061 records found ]

el 1D st st Mi City sise 20 Eith = E:tes Support Lindecid Soppot e el Support [Note] Undecided [Note] [
upport [Date]
108
128235 | Agbbatt-Stili.. | James Jo St Michael MN | 55376 1/1/1343 | M Wrght | 006 |30 |30B | 1566261
128297 | Aabel Jenifer D. New Brighton | MN | 55112 14171960 | F Ramsey (004 |41 |41B | 2205002
128258 | Asbel John C.ihvd New Brighton | MN | 55112 1/1/1961 | M Ramsey |004 |41 |41B | 2205003
128293 | Aaberg Allan C..|Ave Starbuck MN | 56381 14141961 | M Pope 007 12 [12A | 3899896
2 Aaberg Jamon J..fve N Robbinsdale | MN | 55422 14141971 | M Henne... |005 |45 |458 | 1473706
4 Aaberg Mariory. E. Starbuck MN | 56381 14141961 | F Pope 07 |13 [13A  [1512013
5 Aaker Kalynn K. Path Lakevile MN | 55044-5974 14141977 | F Dakota |0D0Z |58 |58A | 3940986 6/11/2012
6 Aalders HNicki Jo.pAveN Crystal MN | 554284623 1/1/1963 | F Henne.. | 005 |45 |45A | 1544345
Fi Aalegaard Wen Jo |Ave N Crystal MN | 554272757 17171977 | F Henne.. |005 |45 |458 | 3599865
8 Aalgaard Heather A e N Crystal MN | 55427 1411977 | F Henne... 005 |45 |458 | 3457082
10 Aalgzard Tad R.veN Crystal MN | 55427 14141972 | M Henne... | 005 |45 | 458 | 3457081
1" Aalsma ron J..fe N Mew Hope MM | 55428 1/1/1978 | M Henne... | 005 |45 |45A |2430043
12 Aalsma Natalie S.keN Mew Hope MN | 55428 1/1/1976 | F Henne... | 005 |45 |45A | 3793575
13 Aamodt John E.reN Crystal MN | 55427 14141928 | M Henne.. (005 |45 |458 |956279
14 Aamodt Sc J.feN Crystal MN | 55428 14171971 | M Henne... 005 |45 |45A | 3327162 6/11/2012
18 Aanerud-Valis | Cordiss Ao Ave N MNew Hope MN | 55427 1/1/1966 | F Henne... | D05 |45 |48A | 1167572 6/11/2012
19 Aames Jaimi C.|AveN New Hope MN | 55428 14141971 | F Henne... 005 |45 |45A |1551225
46586 Aaron Bev d Baton Rouge | LA | 70802 F
20 Aaron Shidey C..pAve N Minnezpolis MM | 55411 1/1/1936 | F Henne... |05 |58 |58B 1067048
29 Aasend Jeanette A ke N Golden Valley ' MN | 55422 1/41/1932 | F Henne... | 005 |45 |458 | 997067
35 Abbatt Linda L.weN Crystal MN | 55422 1/1/1944 | F Henne.. |005 |45 |458 | 1485862
37 Abbott Tommy R weN Crystal MN | 55422 1/1/1943 | M Henne... 005 |45 |458 |954062
38 Abboud Cathy J.feN Golden Valley | MN | 55422 1/1/1957 | F Henne.. | 005 |45 | 458 | 1203059 M [l 7]
41 Abdoullahi Abdousalam | O ke N Crystal MM | 55427 1/1/1855 Henne. |05 |45 |458 | 3470960 pe—————— o
| | | | | | | | 1 | [ [ 2 [ 15 | 615 | | \ ql
] | L | v

Joel Kristenson

Calculator

Totals for the Attribute Value colurTms will display at the bottom.

|L—_| Save

‘ |»E Save and Close | [& Reports ] [#? Mew

) [@Cancd_]
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At this point you're finished with this process. Continue reading for tips on other useful task you can perform from this point forward, and
checkout the related resources at the bottom for links to other articles and videos.

Export

Option 1 - The quickest way to run an export to a .csv file would be to click the [Export] button on the list tool strip. (Image below).
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<3» Search ¥, Reset | 4k New (= | L) OF ¢ | File + Edit - | ) | §pInclude Other | Voters |
Q

| Favorites | General | Address | Household | Vote History | /* Attribute | Canvass | Poll | Lawn Sign | Contribute | Pledge | Event | Log | Admin | QL |

A Include | Exclude

@ I

© In precisely Attribute Yes Date From
In at least S Voter Candidate S .
) In range =
@ nal 2% Does Not Support
1 el E ~Ef Undecided

af 3 selected Eﬂ"{ﬁ Voter [ssues

(= | ===

4| m " 3
=8 - || i i = Pi
E S8 Edit | % Include % Exclude ) Sort ) Format & Print |§| Summary [D E Pivot |

Voters [ 2061 records found ]

Xpo O a .csville Export Contents of List D Not - |
First Reg i ) — Suppart Undecided Does
Incl 1D Last Mame Name MI Id Mot Support Undecidr  Support [Date] [Date] [Nnte:D I
Support [Date] |
132097 Rich Pac 6/11/2012 |
128295 | Asbbatt-Stiich | James John 1566261 6/11/2012 |
128297 | Asbel Jenifer Da 2205002
128298 | Asbel John ark 2205003 |
128295 | Asberg Alan Christopher | | 3899396
2 Azberg Jamon Jerome 1473706 i
4 Asberg Mariory Florence 1512013 i
5 Aaker Kahmn Kay 3940986 6/11/2012 |
3 Azlders Nicki Joy 1544345 |
7 Aaleqaard Wen Jo 3559865 -
32 | | | | 2 [ 1465 | 615 | | |
Ll n . F
Logon=  Joel Kristenson |H Save | |L_@ Save and Close | [&a Reports ] [q‘F MNew ] [lﬁ}CanDel ] !
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Option 2 — To export a householded list and/or to add additional data to the export follow File > Utilities > Export from the file drop-down menu at
the top. (Image below).
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<o Search M, Reset | 4k New ™= | ) ¥ @ [[File < Edit + | 0 | S Include Other | Voters
ﬂ' % Communications  »
|Fa1rm'i&5|5€:'}e'd |Md'&ss|Hot.tsa‘]dd |‘u’::t&l-istoa'y| y ;ll'i 3 Reporting d i : L
Litilities b= Eyport...
A Include | Exclude I{‘h—l T Expo
@ Import... |
I Im[ Export with options ]FI"I State File
() In precisehy Mtribut =
@ In at least n[‘] % Vot o Delete Selected Records... 2
— = er Candidate Support
II::HI = 1
f‘:‘u :: :IHQE %g Does Not Support Merge...
1_ Ew [0 Bk Support Find possible duplicates...
H to : = 3 -
3 selocted 4 =-§ Undecided Split Couples into Separate Voters..,
select H-=h Voter lssues i o
(28 Sortin household walking list order...
e 2 [
< | i | S

EE Edit | % Include % Exclude ﬁﬁort @Format - ma Export &Print IE Summary ED E F‘ivot .

nd D LastName s M Feg E.Igtes Suppot Undecid Suppott e e
upport [Date]

132057 Rich Pac 6/11/2012

128295 | Aabbatt-Stilich | James John 1566261 6/11/2012

128257 | Aabel Jenifer Da 2205002

128298 | Asbsl dohn Clark 2205003

128233 | Agberg Allan Christopher | | 3339836

2 Aaberg Jamon Jerome 1473706

4 Aaberg Maricry Florence 1512013

3 Agker Kahymn Kay 3540986 6/11/2012

4 Aalders Micki Joy 1544345

7 Aalegaard Wen Jo 3559865 -
32| | | | 2 [ 1445 | 615 | | |
1 1 ! P

Logon=  Joel Kristenson ||.-.| Cmvra | L & Save and Close | [.& Repnrts ] [q'h [P ] [l.'@'JCanDEI ]
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Print
To simply print your list on paper, click the [Print] button from the list tool strip. (Two images below).

Image 1 — Print
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<3 Search Y. Reset | dk New t= L) ¥ @ | File+ Edit - | 0 | SgpInclude Other | Voters
%]

| Favarites | General | Address | Household | Vote History | & Attribute | Canvass | Pall | Lawn Sign | Contribute | Pledge | Event | Log | Admin | saL |

A Include | Exclude
) In precisely Attribute Yes Date From Date To
@ In at lzast
@ B- Voter Candidate Support
73 In range 1=, E I,_:|
A Inal ~Sa& Does Not Support
i i B8 Support
I _Hep ]|, ~Ef Undecided
of 3 selected B Voter lssues L]
-0
i | UL | L

S8 Edit | % Include % Exclude & Sort ) Format - mEE}q::HJ |& Prini|| Detail ||§] Summary [D E (B Pivot |

Voters [ 2061 records found ]

Print Contents of List -
el 1D Last Name st M Tdress ddess City State 2P, g G
132097 Rich Pac @ 12526 270th Ave Isle MN | BB342
128295 | Aabbatt-Strilich James John @ 103 Meadowlar Rd ... || 5t Michael MN | 55376 14115459 | M
128357 | Agbel Jenifer Da Eﬁ] 1510 Siowe Blvd MNew Brighton | MM | 55112 1411960 | F
128238 | Asbel dJohn Clark @ 1510 Siowx Blvd MNew Brighton | MM | 55112 14141961 | M
128735 | Asberg Allan Christopher @ 216596 253nd Ave Starbuck MN | BB3B1 1/1/1961 | M
2 Aaberg Jaman Jerome Eﬁ] 3515 Moble Ave M Robbinsdale MM | 55422 114571 |M
4 Aaberg Marjory Horence @ 504 Bth St E Starbuck MN | 56381 14141961 | F
5 Aaker Kahmn Kay @ 20644 Justice Path Lakeville MN | 55044-55974 11415977 | F
6 Aalders Micki Joy @ 4756 Georgia Ave N Crystal MM | 5h428-4629 1/1/1963 | F
i Aalegaard Wen Jo @ 3040 Sumter Ave N Crystal MM | Bh427-2757 111977 |F =
2 | I | | L | L

] m " 3

| Logon=  Joel Kristenson |||—|| Save | |L_@ Save and Close | [&.‘a Reports ] [# Mesw ] [(é}(:anoel ]
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Image 2 — Print Preview (in landscape mode)
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You may have to adjust the margins and orientation of the grid in order to get it
to fit on paper correctly.

&5 Print | ¥ 5 |Bgless BEMore | (D Q1 @ @ | L& Print Settings
Voters l 2061 records found ] DateMime: 422/2015 %12 AM Page: 1
Last Name  First Name  Address City State Does Supp... Unde.. Does Support Undecided Does Support Undecided [No...
[Date] [Date] [Note]
Not Not Not
Supp.. Support Support
[Date] [Note]
Aaberg Jamon 3915 Moble Ave M Robbinsdale MM X
Aaberg Marjory 504 §th StE Starbuck MM X
Aaker Kalynn 20644 Justice Path | Lakeville MM X gM11/2012
Aalders Micki 4756 Georgia Ave N | Crystal MM X
Aalegaard Wendy 3040 Sumter Ave N | Crystal MM X
Aalgaard Heather 6600 32nd Ave N Crystal MM X I
Aalgaard Tad 5600 32nd Ave N Crystal MM X
Aalsma Aaron 8500 56th Ave M Mew Hope MM X
Aalsma Matalie G500 B6th Ave N Mew Hope MM X
Aamodt John 6905 35th Ave M Crystal MM X I
Aamodt Scott 7011 58th Ave M Crystal MM X aM11/2012
Aanerud-Va.., Corliss 2T15Hillsboro Ave..| Mew Hope MM X gM11/2012
Aarnes Jaimi 4215 Oregon Ave M | Mew Hope MM X
Aaron Shirley 1430 Mewton Ave M | Minneapaolis MM X
Aaserud Jeanette 5301 33rd Ave M Golden Vallgy MM X
Abbott Linda 5700 32nd Ave N Crystal MM X
Abbott Tommy BT00 32nd Ave N Crystal MM X
Abboud Cathy 2801 Kyle Ave M Golden Valley MM X
Abdoullahi Abdousalam | 8817 37th Ave N Crystal MM X
Abel Benjamin 4325 Zane Ave N Crystal MM X
Abel Leonard 8425 3Tth Ave M Crystal MM X
Abel Matt 3445 FloridaAve M | Crystal MM X
Abele Marie 3800 UnionTer Ln N | Plymouth MM X 3282012
Abele Mikel 6648 Edgemont Blvd | Brooklyn Park MM X 3/28/2012 i
Abesay Azeb 3704 Welcome Av... | Crystal MM X \
Abraham Jessica 2310 Unity Ave N Golden Valley MM X Bi4izinz2 Py
Abrahamson | Brett 2815 Jewel Ln M Plymouth MM X 8M11/2012
Abts Brian 8701 81st Ave N Mew Hope MM X 8M11/2012
Ackerman Glen 4950 Bassett Cree... | Golden Valley MM X 81172012
Ackerson Bernerd 5430 Boone Ave N Mew Hope MM X 3282012 -
Adam Peter 4408 Flag Ave N Mew Hope MM X Attn b ute
Adams Aleta 4725 Welcome Av... | Crystal MM X
Adams Catherine 3838 |daho Ave N Crystal MM X C
Adams Christopher = 13800 74th PI N Maple Grove MM X 0 I u m ns
Adams Eric 4534 Welcome Av...  Crystal MM X
Adams Michael 4534 Welcome Av... | Crystal MM X
Adams Rita 4534 Welcome Av...  Crystal MM X
Adams Robert 3838 |daho Ave N Crystal MM X
Adamson Blake 7024 35th PI N Crystal MM X
Adderley Alisha 6305 Camden Ave N | Brooklyn Ce.. MM X
Addy Scoft 1081 Piper Dr Mew Brighton MM X gM11/2012
Ademite Frank 2785 Scott Ave N Golden Valley MM X Bi42012
Aebly George 3419 Welcome Av...  Crystal MM X
|
1 [']
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Generate a Walk List
To create a quick walk list using the current list click the [Reports] button in the bottom-right and select Walk List Selectable Format.
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Attribute Yes Date From Date Ta MNote
== Voter Candidate Support
‘='§ Does Not Support

I i Select a rEle"ttO pnl_'iL E

<=

Reports
L A Simple List
& List with User Fields 5
List with Motes
Simple Volurteer List
Yolunteer List
Fundraising List
Labels (Use Avery 5160) IRot
Labels (Use Aveny 5160)/Nick Name Option I
Labels Name built by list-Combined House or by last name and address
Labels Household and Envelope Mame (Use Avery 5160)
Mame Badge First = Last Mames + Employer {Use Avery 5392)

3

m
=

i

Brehe=—First—=tmst-ames (Use Ave Support lUndecided gﬁesurm Support L|r|:|:|
Walk List, Selectable Format [Date] [Date] [N;F;] [Mate] [No

—

[Legacy] Walk List. Simple, 2 Checked -

(L wecls wecls we
= r
e

@

] [@Canc:el ] 6/11/2012

B ——"— ——— —
3040 Sumter Ave N N

|y wecls wex)

4215 Oregon Ave N Mew Hope MM

tl0EEEOOEE = 2

F F
" 660032nd Ave N || Ciystal MN
! 6600 32nd Ave N || Cystal MN
/| 8500 56th Ave N New Hope | MN
/| 8500 56th Ave N New Hope | MN
| 6308 35th Ave N Crystal MN
" 70115%h AveN || Cystal MN 6/11/2012
E 2715 Hillsboro Ave N || New Hope MM 6/11/2012
!
2

—
o
'y
tn

(L 2

|H Save ||h@ Save and Close il&ﬂepnrts Ii# Mew ”Q@Cﬂm&l ]
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Here’s the print preview on how the walk list looks with the attribute columns included.
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Print preview of the walk list with attributes included.

o Print | J& = EE Less EE Mare @ o 1 @ Q :EPrint Settings

& TrailBlazer

Walking List 4/22/2015 wiAttributes  Page: 1 of 103 -4/22/2015 9:27 AM
Last Mame FirstMame Does M. Support Undecid.Does Mot .. Support [Da.Undecided [[Does Mot ..Support [M.Undecided [Mo...

PO Box 97275, Raleigh, NC 27624 [Precinct Code=]
McMichael Collin ] ¥ [] 086/06/2079 10/26/2011 06/06/2079

PO Box 94125, Baton Rouge, LA 70804 [Precinct Code=]
Windham Steve ] [l 06/06/2079 06/11/2012 06/06/2079

PO Box 580277, Minneapolis, MN 55458 [Precinct Code=]
Falmer-Denig Jessica [] O06/06/2079 06/11/2012 06/06/2079

1, Baltimore, DC 11111 [Precinct Code=]
Rosenbrough Van

]

O
[

O
x

| ] 06/06/2079 06/1/2012 06/06/2079
2465 102nd St, Fosston, MN 56542 [Precinct Code=0035, Precinct N\ame=HEIER TWP]

Green Stephen ] | [] 06/06/2079 06/1/2012 06/06/2079 E
5704 103rd Ave N, Brooklyn Park, MN 55443 [Precinct Code=0330, Precinct Name=BROOKLYN PARK W-C P-7]
Lanser Trisha O ] [] 06/06/2079 06/11/2012 06/06/2079

1911 103rd Ave NW, Apt 2, Coon Rapids, MN 55433 [Precinct Code=1215, Precinct Name=COON RAPIDS W-3 P-3]
Hall Joshua O | 06/06/2079 06/06/2079 06/06/2079

6423 104th Ave N, Brooklyn Park, MN 55445 [Precinct Code=0335, Precinct N\ame=BROOKLYN PARK W-C P-8]
Duffney Mark Il | [] 06/06/2079 06/1/2012 06/06/2079

8001 107th St W, Bloomington, MN 55438 [Precinct Code=0060, Precinct Name=BLOOMINGTON W-2 P-24]

Pham Phaong [l "4 |1 06/062079 06/11/2012 06/06/2079

Poole Elizabeth ] ] [1 06/06/2079 06/1/2012 06/06/2079

2767 108th Ln NE, Blaine, MN 55449 [Precinct Code=0330, Precinct Mame=ELAINE W-1 P-6]

Zacher Laurel ] O |«] 0B6/06/2079 06/06/2079 06/06/2079

7710 116th Ave N, Champlin, MN 55316 [Precinct Code=0460, Precinct Name=CHAMPLIN W-3 P-01]

Urquhart Christine O Fl 06/06/2079 06/06/2079 06/06/2079

Urquhart Steven O |«] 06/06/2079 06/06/2079 06/06/2079

307 11th Ave, Worthington, MN 56187 [Precinct Code=0175, Precinct Name=WORTHINGTON W-2 P-2]

Buxengard Cathy ] ] [[] O06/06/2079 06/1/2012 06/06/2079

64761 120th §t, Adams, MN 55909 [Precinct Code=0010, Precinct Name=ADAMS TWP.] I

Schneider Mike J | [1 06/08/2079 06/11/2012 06/06/2079

1015 121st Ave NW, Coon Rapids, MN 55448 [Precinct Code=3410, Precinct Name=COON RAPIDS W-2 P-1] 21
Poltiske Cassondra ] jod |

| | 06/06/2079 06M1/2012 06/06/2079

4 (L 2
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Oroanbe. Leverage. Succeed. Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

Save Format and Set as Default
If you plan on using the format you created again in the future, click on the Format drop-down menu and select Save-As. (Image below).
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Grid by Formatting them in as Columns

g Search %, Reset | oF New | 0= | k) ¥ @ | File + Edit - | & | &gInclude Other | Voters |

Q

| Favortes | General | Address | Household | Vote History | &% Attribute | Canvass | Poll | Lawn Sign | Contribute | Pledae | Event | Log | Admin | saL |
A Include | Exclude

Q

© In precisely Attribute Yes Date From
© Inatleast 5= Voter Candidate Support
7 In range
® nal .:% Does Not Support
I BHelp E ~Ef Undecided

of 3 selected +=  Voter lssues

M= ===

= i - || & i i = Pi
SEEdit | % Include % Exclude | Sort [ Format || &% Export /2 Print ||Detall | Summary [[] = |[E Pivot |

<System Format>

Voters [ 2061 records found ]

B Columns..
Does Mot Support Undecided Does

Last First .
Address Select other... = Support  Undecid Suppart Suppo
MName E [Date] [Date] [Date] [Mote]

Aames imi | 4215 Orp -
= . IE ra30 NP Savehs.. |l
Lasenud |E @ Assign as default
nda |
[

O3
<l | [l
[|E|=

(=]
Eu
=
[=1]

Me [l
Abbatt 5700 2nd BVET | rjlﬂﬂ'l Save the current format under a specified name 1!

Abbott 5700 32nd Ave N || Crystal MN
Abboud 1" 2801 Kyle Ave N Golden Valley | MN
Abdoullahi | Abdousalam || 6617 37h Ave N Crystal MN
Abel Beniamin  ||" 4325 Zane Ave N || Crystal MN
Abel |/ 6425 37th Ave N MN

OOoOooE
H|0OE@E
0= ===
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Grid by Formatting them in as Columns

If you want to set it as the default for either you, another user, or all users - click the Format drop-down, and select Assign as Default. (Image
below).
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9 D&gﬁé!xgdzer Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

g Search %, Reset | oF New r_-| ) ¥ (%  File - Edit - | 0 | §mInclude Other Voters |

Q

| Favortes | General | Address | Household | Vote History | &% Attribute | Canvass | Poll | Lawn Sign | Contribute | Pledae | Event | Log | Admin | saL |
A Include | Exclude

Q

© In precisely Attribute Yes Date From
@ In at least 5 Voter Candidate S I
7 In range
® nal .:% Does Not Support
I BHelp E ~Ef Undecided

of 3 selected ]ﬁ Vater lssues

M= ===

= i - || & i i = Pi
SEEdit | % Include % Exclude | Sort [ Format X Export i Print |Detall | Summary [[] = |[E Pivot |

<System Format>

Voters [ 2061 records found ]

B Columns..

Does Does Mot Does
— = Address E’ Select other... = Mot Support Undecid Support [SE]J:E;H l["E]na‘::?dEd Suppo

e e [Date] [Note]

kil Save

(E-aL1e]
E 143DN ;’B Save As,.,

@ Assign as default... J

Aames |
Aaron |
Aasenud |
Abbott |
ae |
Abbott I S e e LiEn Assig hen displaying information in this grid
f
fl-
IF

Abboud 2801 Kyle Ave N Golden Valley T
Abdoullahi Abdousalam 6617 37h Ave M Crystal MM
Abel Benjamin 4325 Fane Ave N Crystal MM
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Organize, Leverage. Succeed.

Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

Make Columns Updateable in the Grid View for Batch Data Entry

If you are performing a task such as distributing and re-entering data for paper walks, it can be much quicker if you perform the task in the grid

view vs. going into each voter record and manually updating the attributes. To make a column updateable click the Format drop-down, and select

columns.

+H4  Voter Issues

<System Format:=

=4

Columns...

Select other...

Save

Save As..,

Tt

Does Mot . D
Support  Undecidi PSFI‘Jpp?rt [SE]J;F:;“ lr[llnactlg?dm S

[ Add or remove columns, apply formatting, or specify column attributes.

Crystal

Golden Valley

Abdousalam

| 6617 37th Ave N

Crystal

Benjamin

T o T
S EHE S| s |

O || | T { e

|" 4325 Zane Ave N || Crystal
IF ;

i
1
i

Then navigate to the Format tab and check the boxes in the Updateable columns, and click [OK].
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Grid by Formatting them in as Columns

.m- Column Selection l

|
||thm1s|ﬁdtrh.tes|‘u’ntel-isti'y_| Furrnat|| 1
|
——

Format

=+

Column Heading Filter Visible — Width Frozen  Updatable 1

Address [DefaultDisplay] SD sD
Address [Default Display] LD LD
Sec. of 5t. Voter # Reg Id
Does Mot Support
Support Support
Undecided Undecided
Does Mot Support [Date]
Support [Date]
Undecided [Date]

Does Mot Support [Mote]
I

<=l =)=

T
T
T
B
B
B
D
D
D
T

<=l ==
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Grid by Formatting them in as Columns

That allows you to then click the [Edit] button once you’re back in the grid view, turning the columns green, allowing you to go row by row
updating the information.
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«3Search %, Reset | 4k New 0 | L) ¥ {4 | File - Edit » | ) | §gInclude Other | Voters
Q

| Favorites | General | Address | Housshold | Vote History | 4% Attibute | Canvass | Poll | Lawn Sign | Contribute [ Pledge | Event | Log [ Admin [ sal

& Include | Exclude:
% () In precisety Attribute: Yes Date From Date:
@ In at least -
S Veter Candidate Support v
) In range S8 Does Support P
©inal Eg &m:m
T O |, [ s
of 3 selected = Voter lssues —D
"i l

% Include % Exclude | [ Sort B Format - | &% Bxport (2 Print Summary []] = |[E Pivot |

Voters [ 2061 records found ]

Does [pes Mot
= Address Ciy s} et | et | Umicid) o e | =
fames Jaimi |E 4215 Oregon Ave M Mew Hope MM
Haron Shidey |E 1430 Newton Ave N Minneapolis MM

||| Asserud Jeanette [ 5301 33d Ave N Golden Valley | MN
||| Abbott Linda || 5700 32nd Ave N || Crystal MN
Abbott Tommy  |[{570032nd AveN || Crystal MN
Abboud Cathy |/ 2801 Kyle Ave N Golden Valley | MN
Abdoullahi |/ 6617 37th Ave N Crystal MN
Abel 4325 Zane Ave N || Crystal MN
Abel Leonard | 6425 37 Ave N Crystal MN

||| Abel Matt |/ 3448 Florida Ave N || Crystal MN
ele Marie Plymouth MN
Brookyn Park

B
<
E

Golden Valley | MN 5/4/2012

1/ 2815 Jewel Ln N Pymocth MN 6/11/2012

Abts Brian ¥ 3701 1st Ave N New Hope MN 6/11/2012

Ackerman | Glen |/ 4950 Bassett Creek .|| Golden Valley | MN 6/11/2012

Ackerson erd  |/5430 Boone Ave N || New Hope | MN 3/28/2012
Adam Peter E 4408 Flag Ave N New Hope MM
||| Adams Pleta |/ 4725 Welcome Ave N || Crystal MN
||| Adams Catherine || 3838 Idsho Ave N || Crystal MN

Adams Christopher [/ 13600 74h FIN Maple Grove | MIN n/kb 29
Enic " 4534 Welcome Ave N || Cystal MN
| " 4534 Welcome Ave N || Cystal MN
7 4534 Welcome Ave N || Crystal MN
Al [ Il T A2 T 1225 | &15 | ||
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Organize, Leverage. Succeed.

Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

0009

g

Trail Blazer
- YouTube Channel

- Knowledge Base Articles
- 3rd Party Resources

Related Resources

Article: Walk List Selectable Format
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Oroanbe. Leverage. Succeed. Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

Article: Create Attribute Folders, and Attribute Items
Article: Mobile Base Camp

Video: Add attribute dates and notes to your list
Video: Walk List Using Format Display

Video: Mobile Canvassing App — Pinpoint Canvassing

Trail Blazer Live Support

© Phone: 1-866-909-8700
® Email: support@trailblz.com

El Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.

Click here to view our calendar for upcoming classes and events feel free to sign up other members on your team for the same training.
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Qrganize. Leverage. Succeed. Add Attributes, Attribute Dates, and Attribute Notes to the
Grid by Formatting them in as Columns

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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